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PURPOSE 
This module covers the use of Audacity 1.3 hosted on an IBM 
Cloud Instance 
Topics include accessing,  and running Audacity. 
Manipulating audio files such as splitting, copying, pasting, 
merging, and exporting are covered. 



ABOUT AUDACITY 
Audacity is a free software, cross-platform digital audio 
editor and recording application. It is available 
for Windows, Mac OS X, Linux and BSD. 
Audacity was created by Dominic Mazzoni while he was a 
graduate student at Carnegie Mellon University. Mazzoni now 
works at Google, but is still the main developer and 
maintainer of Audacity, with help from many others around 
the world. 
The latest release of Audacity is 1.3.13, a beta, released on 11 
April 2011. As of 29 October 2010, it was the 10th most 
popular download from SourceForge.net, with 72 million 
downloads. Audacity won the SourceForge.net 2007 
Community Choice Award for Best Project for Multimedia. 
 



AUDACITY 
RESOURCES 
Audacity home page. 

•  Tutorials and manual. 
 

Wikipedia entry for Audacity. 



ACCESSING THE 
CLOUD INSTANCE 
All of the resources for the learning module are located on an 
IBM Cloud Instance 

 Running Windows Server® Datacenter  
 32-bit, 2.27GHz, 2.00 GB RAM 

 

Login Credentials: 

 IP: 170.225.97.129 

 Username: admin 
 Password: ******** 

 



ACCESSING THE 
CLOUD INSTANCE 
Using Windows, open the Remote Desktop Connection utility 

 >> Start >> All Programs >> Accessories >> Remote Desktop Connection 



ACCESSING THE 
CLOUD INSTANCE 
Inside of the Computer Field, type ‘170.225.97.129’ 
 
 
 
 
 
 
 
 
 
Press ‘Connect’ 



ACCESSING THE 
CLOUD INSTANCE 
You will be prompted for a username and password 

 Username: admin 
 Password: ******** 



ACCESSING THE 
CLOUD INSTANCE 
You will then be logged into the IBM Cloud Instance 



OPENING AUDACITY 
Double-click on the Audacity 1.3 icon of the Desktop 
 
You will be presented with Audacity’s home view 



AUDACITY 
COMPONENTS 

Main toolbar 

I/O sliders 
Input selector 

Edit toolbar 



AUDACITY 
COMPONENTS 
Main toolbar – Contains tools for playback, recording, and 
viewing audio. 
 
Edit toolbar - All these tools perform the exact same function 
as those accessible through the Edit menu, 
View menu and keyboard shortcuts. Used for manipulating 
audio signals. 
 
I/O sliders – Control the mixer settings of the sound card. 
 
Input selector - Pick the input source you wish to record 
from. All these items are exposed by the soundcard driver, 
so the this of options will vary with different soundcards. 



AUDACITY 
PREFERENCES 
The preferences dialog can be accessed by clicking Edit >> 
Preferences from the top menu, or by pressing Control+P 



PREFERENCES – 
AUDIO I/O 
The two drop-down list controls in this pane is where you configure which device Audacity should 
use for sound input and output. This basically means which sound card, USB sound device, etc you 
want to use. If your sound card support multiple sound inputs, e.g. has a microphone input and a line-
in, then you select these on the mixer toolbar. No need to adjust this if Audacityis already playing to 
and recording from the correct place. 

Record in Stereo: If this is checked, recordings you make in Audacity will be stereo, otherwise they 
will be monaural. Note that the interpretation of mono recordings depends on your system - on most 
systems making a mono recording of a stereo input will result in the two channels being mixed, but on 
other systems it could give you just the left channel, for example. 

Play other tracks while recording new one: Check this box if you want to record multiple tracks 
over top of one another! Record the first track as usual. Then, with this box checked, click record 
again. The first track you recorded will play, but Audacity will also record a new track at the same 
time, maybe allowing you to sing harmony with yourself or add real-time sound effects to a recording.  
You may notice that when you play the two tracks you recorded together, they aren't synchronized. 
This is normal and is not the fault of Audacity. To fix it, you will need to grab the Time Shift tool and 
slide one of the tracks around until it sounds right. 
Hardware Playthrough (Mac Only): This sets up your computer to send the sound coming in to be 
recorded straight back out of the speakers, so you can hear what you are recording. Hardware 
playthrough has no latency and takes no CPU, but is only possible if your input and output are on the 
same audio device, and that device supports it. 
Windows and Linux users can enable this using your operating system's Mixer, by simply turning up 
the level for the input you are using and unmuting it. 
Software Playthrough: This enables you to hear what you are recording by taking the data about to 
be recorded by audacity, and playing it back out of the sound card. This works with any duplex sound 
card, or combination of sound devices, so you can record in through an external USB device and play 
back through the computer's built in sound device or vice versa.  
Because of the delays in processing the audio on the computer, there will be some delay 
or latency in the sound that you hear. It also needs some CPU power, so if you have an old machine 
and are getting breaks in your recordings try turning it off. 



PREFERENCES - 
QUALITY 
This panel sets the default sample rate and bit depth for new 
projects. It does not affect any existing project - to change the 
sample rate of an existing project, just click on the rate at the 
bottom of the window and select a new rate from the pop-up 
menu. 

The bit depth affects imported material, if it's copied, as well as 
newly recorded material. The advantage of the 32-bit float 
resolution is that effects return material at a this resolution, which 
improves the final mix, because the computer has more precise 
material to work with. If you aren't doing any processing then you 
may want to save some space by setting this to 16 bit, if your 
hardware supports this. 

 



PREFERENCES – FILE 
FORMATS 
When importing uncompressed audio files... 

•  Make a copy of the file to edit: selecting this means that Audacity will run a little bit 
slower, but it will always have its own copy of any audio you are using in a project. You 
can move, change, or throw away your files immediately after you open or import them 
into Audacity. 

•  Edit the original in place: selecting this operation means that Audacity depends on your 
original audio files being there, and only stores changes you make to these files. If you 
move, change, or throw away one of the files you imported into Audacity, your project 
may become unusable. However, because Audacity doesn't need to make copies of 
everything, it can import files much more quickly this way. If you want to send projects to 
other people or archive them, then select this option. 

 
 
Uncompressed Export Format: This lets you select the format that Audacity will use when 
you export uncompressed files, i.e. anything other than lossy formats, such as OGG and MP3. 
Audacity can output a huge amount of different formats with the Other option, which lets you 
define any aspect of the multitude of different formats. 
For most users, 16 bit WAV (Microsoft) or AIFF (Mac) files will be the most compatible. 

Ogg Export Setup: Use this control to set the quality of Ogg Vorbis exporting. Ogg Vorbis is a 
compressed audio format similar to MP3, but free of patents and licensing fees. A normal 
quality Ogg Vorbis file is encoded with a quality setting of "5". Note that unlike MP3 encoding, 
Ogg Vorbis does not let you set a bitrate, because some audio clips are easier to compress 
than others. Increasing the quality will always increase the file size, however. 
MP3 Export Setup: Use these controls to locate your MP3 encoder and set the quality of MP3 
encoding. Higher quality files take up more space, so you will need to find the level of quality 
you feel is the best compromise. For more information, see Exporting MP3 Files. 



PREFERENCES - 
SPECTROGRAMS 
You can view any audio track as a Spectrogram instead of a 
Waveform by selecting one of the Spectral views from the track's 
pop-up menu. This dialog lets you adjust some of the settings for 
these spectrograms. 
FFT Size: The size of the Fast Fourier Transform (FFT) affects how 
much vertical (frequency) detail you see. Larger FFT sizes give you 
more low frequency resolution and less temporal resolution, and they 
are slower. 
Grayscale: Select this for gray spectrograms instead of colored 
ones. 
Maximum Frequency: Set this value anywhere from a couple of 
hundred hertz to half the sample rate (i.e. 22050 Hz if the sample rate 
is 44100 Hz). For some applications, such as speech recognition or 
pitch extraction, very high frequencies are not important (visually), so 
this allows you to hide these and only focus on the ones you care 
about. 
 



PREFERENCES - 
DIRECTORIES 
Use this panel to set the location of Audacity's temporary 
directory. Audacity uses this directory whenever you work on a 
project that you haven't saved as an Audacity Project (AUP file) 
yet. You have to restart Audacity (close and open it again) for 
changes to the temporary directory to take effect. 
This directory can contain a lot of files and is used a lot, so 
choose a disk with plenty of free space to put it on. Never put it on 
a network drive. 



PREFERENCES - 
INTERFACE 
Autoscroll while playing 
page flips to the right when the cursor travels to the right hand end of the wave display, either during playback or recording. Always 
keeps the cursor on screen, but may cause breaks in recording or playback if you have a slow machine. 

Always Allow Pausing 
 

Update spectrogram while playing 
Tries to keep the spectrogram updated while playing. This requires a lot of cpu power, and really isn't a good idea unless you're 
playing a really small piece or have a powerful CPU and plenty of RAM. In combination with Autoscroll while playing this can cause 
pauses during playback or recording. 

Enable Edit Toolbar 
Gives you a toolbar of a few useful functions. Check out the page on the Edit Toolbar for more information. 

Enable Mixer Toolbar 
Turns on display of the Mixer Toolbar used to control soundcard mixer settings. 

Enable Mixer Toolbar 
Turns on display of the Meter Toolbar, with VU meters you can use to monitor the recording and playback levels of your project. 

Quit Audacity upon closing last window 
Sets Audacity to shut down when the last project window you are working is closed. If you turn this off then audacity will keep re-
spawning new blank project windows until you do File > Quit. 

Enable dragging left and right selection edges 
Lets you manipulate selections by clicking on the edges and dragging them along the timeline. 

Enable dragging left and right selection edges 
Sets the transport control button order as:Pause, Play, Stop, Home, End, Record. Rather than: Home, Play, Record, Pause, Stop, 
End. 

Language 
Lets you change the language of the menus and other onscreen text to the language of your choice. Simply choose the correct 
option from the drop-down list. Note that for languages with unusual character sets you need the correct fonts installed. If your 
menus come up all ???? that's what's wrong. 

Minimum of dB mode display range 
This sets up the scale used for logarithmic waveform displays. Because Decibels are logarithmic, it is impossible to have a 0 point 
on the scale, so some very quiet sounds will display as silence. If you you reduce this effect by increasing the range, then the louder 
part of the scale gets squashed, so there is a choice of settings for different uses. -48dB is a good compromise for general work. 



PREFERENCES - 
KEYBOARD 
Commands/Key Combination List 
All commands in Audacity that can be triggered by a keyboard shortcut are 
listed here. Click on the shortcut and the assigned keystroke is highlighted in 
the command/shortcut list. Click on the "Clear" button to erase the keystroke 
assigned to the function selected in the Commands column. 
Adding new shortcuts/changing shortcuts 
Click on the command in the list. Click in to the field next to the "Set" button 
and press any key or combination of command key(Shift,CTRL,ALT) and 
alphanumeric key(everything else). The description of that key or key combo 
will appear in the field or replace the existing keystroke. By clicking on the 
"Set" button, you can add or change this key or key combo as a shortcut to 
the function selected in the Commands list. 
Saving your setup You can export your keyboard shortcut settings for 
safekeeping or to import into audacity on another machine. Use Save... to 
save you settings to a file, Load... to load a saved settings file, 
and Defaults to restore the default audacity settings. 
 



FILE FORMATS 
Audacity Project format (AUP) 

•  Audacity projects are stored in an AUP file, which is a format 
that has been highly optimized for Audacity so that it can open 
and save projects extremely quickly. In order to achieve this 
speed, Audacity breaks larger audio files into several smaller 
pieces and stores these pieces in a directory with a similar 
name as the project. For example, if you name a project 
"chanson", then Audacity will create a project file 
called chanson.aup which stores the general information 
about your project, and it will store your audio in several files 
inside a directory called chanson_data. The Audacity Project 
format is not compatible with any other audio programs, so 
when you are finished working on a project and you want to 
be able to edit the audio in another program, select Export. 



FILE FORMATS 
WAV (Windows Wave format) 

•  This is the default uncompressed audio format on Windows, 
and is supported on almost all computer systems. It can also 
be lightly compressed (about 4:1) using the ADPCM codec, 
but this is less widely supported on non-windows platforms. 
Audacity can read and write this format, including ADPCM on 
all platforms. 



FILE FORMATS 
AIFF (Audio Interchange File Format) 

•  This is the default uncompressed audio format on the 
Macintosh, and it is supported by most computer systems, but 
it is not quite as common as the WAV format. Audacity can 
read and write this format. 



FILE FORMATS 
Sun Au / NeXT 

•  This is the default audio format on Sun and NeXT computers, 
and it is usually u-law compressed so not very high quality. U-
law compression is a very simple, fast but low quality way to 
reduce the size of the audio by about 50%. It is widely used in 
American telephone systems. 
This format was one of the first audio formats supported by 
Web browsers, and it is still often used for short sound effects 
where quality is not as important. Audacity can read this 
format, and write files either in 8-bit u-law compressed or 16-
bit uncompressed variants. 



FILE FORMATS 
IRCAM (Institut de Recherce et Coordination Acoustique/
Musique) 

•  This is a very general file format that is commonly used by 
computer music researchers. Audacity can read this format. 



FILE FORMATS  
MP3 (MPEG I, layer 3) 

•  This is a compressed audio format that is a very popular way 
to store music. It can compress audio by a factor of 10:1 with 
little degradation in quality. Audacity can both import and 
export this format. 



FILE FORMATS 
Ogg Vorbis 

•  This is a new compressed audio format that was designed to 
be a free alternative to MP3 files. Ogg Vorbis files are not as 
common, but they are about the same size as MP3 with better 
quality and no patent restrictions. Audacity can import and 
export this format. 



OPENING A FILE 
Choose File >> Open, or alternatively press Control+O 



OPENING A FILE 
Navigate to the Desktop and select the file ‘Prelude in C – 
BWV 846.mp3’ 
Press Open 



OPENING A FILE 
You will now see the waveforms for the MP3 file inside of 
Audacity 



AUDIO PLAYBACK 
Once you have opened an audio file you can playback the 
audio using the main toolbar 

Pause Play Stop Skip Backwards Skip Forwards Record 



AUDIO PLAYBACK - 
PLAY 
Press the PLAY button 
You will hear the audio playback, the green arrow above the 
waveform moves forward, indicating the elapsed time in the 
track 



AUDIO PLAYBACK - 
PLAY 
To adjust playback, use the audio playback slider (indicated 
by slider).  
The multiplier shown by the slider shows the playback speed 
of the track 



AUDIO PLAYBACK - 
PAUSE 
Press the PAUSE button 
The audio will pause at its current location 
Press the PLAY button 

The audio will resume from its current location 



AUDIO PLAYBACK – 
STOP AND SKIP 
With audio playing, press the STOP button 
The audio stops playing and marker moves to the beginning 
of the track 
The SKIP FORWARD and SKIP BACKWARD buttons become 
enabled 
Press the SKIP FORWARD button 

The marker moves to the end of the track 

Press the SKIP BACKWARD button 

The marker moves to the beginnig of the track 



AUDIO PLAYBACK - 
SEEKING 
Double-click anywhere on the track timeline to begin 
playback from that position 
 
Alternately, you may use the Audio Postion box in the 
bottom-right to choose the marker location 
 



AUDIO EDITING - 
SELECTING 
Click inside of the waveform and drag your cursor to another 
area (the yellow line below represents the drag area) 
A gray selection area will appear on the waveform 



AUDIO EDITING - 
SILENCING 
Select a portion of the wave form 
Click on the silence button (indicated by arrow) 



AUDIO EDITING - 
SILENCING 
You will notice that the selected portion of the waveform has 
become flat 
Play the audio track 
The portion of the track which was silenced becomes silent 



AUDIO EDITING - 
UNDO 
Edit a portion of the wave form by silencing it 
Press the UNDO button (indicated by arrow), or alternatively 
press Control+Z 
 
 
 
 
 
 
You will notice that the edit which was just performed has 
been reverted 



AUDIO EDITING - 
REDO 
Undo an action 
Press the REDO button (indicated by arrow), or alternatively 
press CONTROL+Y 
 
 
 
 
 
 
You will notice that the undo which was just performed has 
been redone 
 



AUDIO EDITING - TRIM 
Select an area of the waveform 
Press the TRIM button (indicated by arrow) 



AUDIO EDITING - TRIM 
Notice that only the selected portion of the waveform 
remains 
Press UNDO to revert the change 



AUDIO EDITING - CUT 
Select a portion of the track’s waveform 
Press the CUT button (indicated by the arrow), or 
alternatively press Control+X 
 

 

 

 

Notice that the selected portion of the waveform has been 
removed 



AUDIO EDITING - 
COPY 
Select a portion of the track’s waveform 
Press the COPY button (indicated by the arrow), or 
alternatively press Control+C 
 

 

 

 

The selected portion of the track is placed on the clipboard 
and will appear at the marker location when pasted. 
 



AUDIO EDITING - 
PASTE 
Cut or copy a portion of the waveform 
Press the PASTE button (indicated by the arrow below), or 
alternatively press Control+V 
 

 

 

 

 
Notice that the audio portion on the clipboard is inserted at 
the current position of the track marker 



AUDIO RECORDING 
Press the RECORD button to begin recording 
 
 

 

 

 

 
 

Microphone input will begin to be drawn as a waveform 

Record 



AUDIO RECORDING 
Press the STOP button to end recording 
 
 
 
 
 
 
 
 
The recorded audio can now be manipulated like a sound file 
that has been imported into Audacity 

Record 



GENERATING NOISE 
From the toolbar, choose Generate >> Noise 
 
 
 
 
 
 
 
Choose your desired Noise type (white, pink or brown), 
amplitude and duraton.  
Press OK 
The noise is added at the current track marker. 
 



GENERATING NOISE 
White noise: A random signal (or process) with a flat power 
spectral density. In other words, the signal contains equal power 
within a fixed bandwidth at any center frequency.  

 

Pink noise: A signal or process with a frequency spectrum such 
that the power spectral density is inversely proportional to 
the frequency. In pink noise, each octave carries an equal amount 
of noise power. 
 

Brown noise: Kind of signal noise produced by Brownian motion, 
hence its alternative name of random walk noise. 



FREQUENCY 
ANALYSIS 
To view the frequency histogram of your current audio track, 
or selected region, select Analyze >> Plot Spectrum… from 
the top menu 



AUDIO EFFECTS 
Audatcity has several effects which can be applied to your 
track. Each effect can be accessed from the top menu by 
clicking on Effect. Going in depth on each effect is out of the 
scope of this learning module, but more information can be 
found here. 



AUDIO EFFECTS -  
AMPLIFY 
This effect increases or decreases the volume of a track or set of 
tracks. When you open the dialog, Audacity automatically 
calculates the maximum amount you could amplify the selected 
audio without causing clipping (from being too loud). 



AUDIO EFFECTS – 
BASS BOOST 
This is a safe, smooth filter which can amplify the lower 
frequencies while leaving most of the other frequencies alone. It is 
most effective if you don't try to boost too much; 12 dB is usually 
just right. 



AUDIO EFFECTS – 
ECHO 
A simple delay line. 
This effect repeats the audio you have selected again and again, softer each time. 
There is a fixed time delay between each repeat. 
First select the audio you want to apply the effect to. You may want to first add 
silence to the end of your track(s) so that the echo has plenty of time to die out. 
When you select "Echo..." from the Effect menu, Audacity will ask you for two 
numbers. 
The first number is the amount of delay between the echos, in seconds. The 
second value is the decay factor, which is a number between 0 and 1. A decay 
factor of 0 means no echo, and a decay factor of 1 means that each echo is just as 
loud as the original. A value of 0.5 means that its amplitude is cut in half each time, 
so it dies out slowly. Smaller values will make it die out even more quickly. 
The Echo effect is very simple and is not intended to be used in place of a Reverb 
effect, which simulates the sound of a room, concert hall, stage, or other natural 
environment. Audacity for MacOS and Windows comes with Gverb, a free LASPA 
Reverb plug-in. 
Note that if you set the decay value to 1.0, you can use Echo to create loops that 
repeat as long as you want any never change volume. 
 



AUDIO EFFECTS – 
FADE IN 
Applies a linear fade-in to the selected audio. 



AUDIO EFFECTS – 
FADE OUT 
Applies a linear fade-out to the selected audio. 



AUDIO EFFECTS – FFT 
FILTER 
This is the most general type of filter. You define a curve that 
shows how much louder or quieter each frequency in the signal 
should be made.  
If you're careful, you can use it to highlight exactly the frequencies 
you want. However, doing an FFT filter is more likely to result in 
artifacts, especially if the filter you draw is not smooth. 



AUDIO EFFECTS – 
INVERT 
This effect flips the audio samples upside-down. This normally 
does not affect the sound of the audio at all. It is occasionally 
useful, for example when the left and right channels of a song 
both contain equal amounts of vocals, but unequal amounts of 
background instruments. By inverting one of the channels and not 
the other, the vocals will cancel each other out, leaving just the 
instrumentals. Obviously this only works if the exact same vocal 
signal is present in both of the channels to begin with. 



AUDIO EFFECTS – 
NOISE REMOVAL 
This effect is ideal for removing constant background noise such as fans, tape 
noise, or hums. It will not work very well for removing talking or music in the 
background. 
Removing noise is a two-step process. In the first step, you select a portion of your 
sound which contains all noise and no signal, in other words, select the part that's 
silent except for the noise. Then choose Noise Removal... from the Effect menu 
and click Get Profile. Audacity learns from this selection what the noise sounds 
like, so it knows what to filter out later. 
Then, select all of the audio where you want the noise removed from and 
choose Noise Removal... again. This time, click the "Remove Noise" button. It 
may take a few seconds or longer depending on how much you selected. 
If too much or not enough noise was removed, you can Undo (from the Edit menu) 
and tryNoise Removal... again with a different noise removal level. You don't have 
to get a new noise profile again if you think the first one was fine. 
Removing noise usually results in some distortion. This is normal and there's 
virtually nothing you can do about it. When there's only a little bit of noise, and the 
signal (i.e. the voice or the music or whatever) is much louder than the noise, this 
effect works well and there's very little audible distortion. But when the noise is 
very loud, when the noise is variable, or when the signal is not much louder than 
the noise, then the result is often too distorted. 
Future versions of Audacity may include improved versions of this effect. 



AUDIO EFFECTS - 
PHASER 
The name "Phaser" comes from "Phase Shifter", because it works 
by combining phase-shifted signals with the original signal. The 
movement of the phase-shifted signals is controlled using a Low 
Frequency Oscillator (LFO). 



AUDIO EFFECTS - 
REVERSE 
This effect reverses the selected audio temporally; after the effect 
the end of the audio will be heard first and the beginning last. 
Some people reverse small portions of audio to make 
inappropriate language unintelligible, while others believe you can 
hear subliminal messages if you listen to speech backwards. You 
can also create interesting sound effects by recording natural 
events and reversing the audio. 



AUDIO EFFECTS - 
WAHWAH 
Just like that guitar sound so popular in the 1970's. 

This effect uses a moving bandpass filter to create its sound. A 
low frequency oscillator (LFO) is used to control the movement of 
the filter throughout the frequency spectrum. 

The WahWah effect automatically adjusts the phase of the left 
and right channels when given a stereo recording, so that the 
effect seems to travel across the speakers. 

 



SAVING AN AUDACITY 
PROJECT 
Choose File >> Save Project As… to select a location to save 
your project 
Audacity creates a .AUP file which can later be imported back 
into Audacity 
After a .AUP file has been created, you can use File >> Save, 
or press Control+S to update that file. 



OPENING AN 
AUDACITY PROJECT 
Choose File >> Open, or alternatively press Control+O 
 
Navigate to your .AUP file and click Open. 

 

The Audacity project will load. 



EXPORTING AUDIO 
Choose File >> Export to select a location to export your file. 
Use the Save as type drop-down box to select the type of file 
to export to 
 



EXPORTING AUDIO 
Options of filetypes to export include: 

  AIFF (Apple) signed 16 bit PCM 
  WAV (Microsoft) signed 16 bit PCM 
  GSM 6.10 WAVE (mobile) 
  MP3 Files 
  Ogg Vorbis Files 
  FLAC Files 
  MP2 Files 
  M4A (AAC) Files (FFmpeg) 
  AC3 Files (FFmpeg) 
  AMR (narrow band) Files (FFmpeg) 
  WMA (version 2) File (FFmpeg) 

 



EXPORTING AUDIO 
Press Save 
 
Your file will now appear at the location that you saved to 



EXPORTING AUDIO 
SELECTION 
Select a portion of an audio track wave form 
 
Chose File >> Export Selection… 

 

The save file dialog will appear as if you are exporting the 
whole track 

  choose a destination and filetype 

 
The file will be created containing only the portion of the 
waveform that was selected. 
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